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Cool Excel formulae!

¢ To calculate someone's age, use DOB and today's date (or Census Date, for example):
=DAYS360(A2,B2)/360
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e Shortcut: todays date " <Ctrl> ;"
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e To concatenate course number and section number here is formula: =CONCATENATE(A2,"*",B2,"*",C2)
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e Text to Columns

For this example, copy cell A2 to B2.
Highlight the B2 cell. Click on the Data tab. Click on Text To Columns. In this example, click on Delimited data type.
Click Next.
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Convert Text to Columns Wizard - Step 1 of 3 M

The Text Wizard has determined that your data is Delimited.

If this is correct, choose Next, or choose the data type that best describes your data.
Original data type
Choose the file type that best describes your data:

" Fixed width - Fields are aligned in columns with spaces between each field.

o (> ] [ oomn ]

On the next step, clear any delimiters that appear and select Other, placing an asterisk (for this example) in the box.
Click Finish.

Convert Text to Columns Wizard - Step 2 of 3 M
This screen lets you set the delimiters your data contains. You can see how your textis affected in
the preview below.
Delimiters
[ T1ab
[ semicolon [7] Treat consecutive delimiters as one
[ comma
o Text gualifier: ™
[ space El
: [¥] other: *
Data preview
503 pz -
y >
Cancel | | <Back | [ Next> || finish
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e To find duplicate values without removing them:
1. Highlight (for example) 1 column.
2. Go to HOME tab
3. Select CONDITIONAL FORMATTING drop down menu
4. Select HIGHLIGHT CELLS RULES
5. Select DUPLICATE VALUES
6. From there you will be given the option of DUPLICATE or UNIQUE VALUES, and the choice of color for the
highlighting.
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e Sparklines

Sparklines (Excel 2010) are best used for tracking trends. It only takes a few clicks of the mouse to insert
them in your sheet. Below are the instructions and one visual example to show how the Sparklines look
when applied to data:

1.0pen your file in Excel 2010 (Excel 2010 will recognize older versions, and you might need to save
you data to a new format [.xIsx], especially if it is “Excel 97-2003 Workbook").

2.Select the cell where you would like your Sparkline to be displayed.

3.Click Insert tab, and then, from the Sparkline menu choose your Line/Column/Win Loss display.

4.Select your range of data.

5.0nce your Sparkline is inserted, the Design tab opens and you will find a few more options for

accessorizing your graph.

Institution Name 1999-2000 2000-01 2001-02 2002-03 200304

UNIVERSITY OF FLORIDA 516 856 607 241 924 ~———
PURDUE UNIVERSITY 468 464 TAD94R3  4de mmm _ mm e
FLORIDA STATE UNIVERSITY 263 260 0B 000 D71 = = mm — ==
OHIO STATE UNIVERSITY 431 587 dps 153 99 ~ A~
THE UNIVERSITY OF TEXAS 659 933 639 B74 002 mm W mmowm

Of course, for detailed graphs, you might still want to design your own chart with all the details you want.
Overall, it is good that Microsoft is beginning to include data visualization applications in their basic
software package without extra charges, and I also think it is good that the 3D Pie Chart is not an option
in the “Sparkline” tab.

o View Two or More Worksheets at the same time

http://office.microsoft.com/en-us/excel-help/view-two-or-more-worksheets-at-the-same-time-
HP001217043.aspx

Using this link will give you instructions of opening two worksheets side by side, viewing two worksheets of
different workbooks side by side, and viewing multiple worksheets at the same time.

View two worksheets in the same workbook side by side

1. On the View tab, in the Window group, click New Window.

35 New Window [ Split == _,:
= Arrange Al " Hide —H sl

= Save Switch
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‘Window
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2. On the View tab, in the Window group, click View Side by Side -~ .

3. Inthe workbook window, click the worksheets that you want to compare.

4. To scroll both worksheets at the same time, click Synchronous Scrolling
View tab.

+/in the Window group on the

Note This option is available only when View Side by Side is turned on.
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Filtering data
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Filtered Data, cont’d.
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e Excel SUBTOTAL Function/Formula
The SUBTOTAL Function in.Excel is used to perform a specified function on a range of Auto filtered cells. When the Auto
Filter has been applied the SUBTOTAL function will only use the visible cells, all hidden rows are ignored. The operation
performed is solely dependent on the number (between 1 and 11) that we supply to its first argument Function_num
For example;

=SUBTOTAL(1,A1:A100)

This will Average all visible cells in the range A1:A100 after an Auto Filter has been applied. If all rows in A1:A100 are
visible it will simply Average them all and give the same result as =AVERAGE(A1:A100)

The number for the first SUBTOTAL argument, Function_num, and its corresponding function are as shown below:
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Function_Num/ Function
1 AVERAGE
2 COUNT

3 COUNTA
4 MAX

5 MIN

6 PRODUCT
7 STDEV

8 STDEVP

9 SUM

10 VAR

11 VARP

¢ Finding Blanks and Copying the Data Above it (Go To Special)

http://www.extendoffice.com/documents/excel/771-excel-fill-blank-cells-with-value-above.html

Following this link, you will find detailed instructions on how to fill blank cells with the value(s)
from above. This is a real time-saving tip as you can see from the following video presentation!

http://www.voutube.com/watch?v=9TDc¢VOKbm34

e Pivot Tables

When Should You Use a Pivot Table?

Large data sets, ever-changing impromptu data requests, and multilayered reporting are absolute
productivity killers if you have to tackle them by hand. Doing hand-to-hand combat with one of
these tasks is not only time consuming, but it also opens the possibility of an untold number of
errors in your analysis. So how do you recognize when to use a pivot table before it is too late?

Generally, a pivot table serves you well in any of the following situations:

*You need to find relationships and groupings within your data.
*You need to find a list of unique values for one field in your data.
*You need to find data trends using various time periods.

*You anticipate frequent requests for changes to your data analysis.
*You need to create subtotals that frequently include new additions.
*You need to organize your data into a format that is easy to chart.
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1. Highlight the cells in the spreadsheet you want to analyze.
2. On the Insert tab, click on Pivot Table. You want a new worksheet, so click OK.
3. Your new worksheet will open and now the fun begins.
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Suppose we want to know gender and ethnicity of full-time and part-time students. We will
click and drag those fields to the column and row labels. We want counts, so we will select the
student ID and drag it to the Values box and set the value to count and click Ok.

[ Value Field Settings =)

Source Name: StudentiD
Custormn Mame: Count of StudentID

Summarize value field by

Choase the type of calaulation that you want to use to summarize
data from the selected field

I

| Sum
| Average |

Min
[Product

[ »

1

(o< ][ cone




Fun with Excel—Cool tips and Tricks
TAIR Conference, 2013

Lisa Haynes and Tracy Stegmair, presenters
Texas Woman's University

We move the Gender variable to the Column Labels box and the Ethnicity variable to the Row
Labels box. We want to look at full-time and part-time separately, so we will move the SCH
variable to the Report Filter box.
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We can now filter for all semester credit hours of 12 and over for full-time or all semester credit
hours of less than 12 for part-time.



VLOOKUP — used to link data on a common vertical data field

Basic formula: = VLOOKUP(lookup_value, table_array, col_index_num, range_lookup)

1 2 34
Formula for this example: = VLOOKUP(A4,'Data 2'!A3:0267,13,0)

1. Value for 2. Range of 3. Column number 4, If seeking
which you data to be of data sought exact match,
want data searched within range “0”

|xi| FE
Al

) .'.A' T 1 ¥
Home Insert Page Layout Formulas

Data Review View Developer Add-Ins Acrobat
& o b 24 . - ) =
ALCESS r Text Sources anne !.4.‘.. A == £t Link -"l ; i o ) iam iplicate -_'_
Get Extevnnl Pt | _Connedtions J Sort & Filter Pt saoh
SUMIF - X v & =VLOOKUP(A4 'Data 2'!A_3:026__?;[3,Q) ) -
A B € . B E F G H
Grand total
(EF2009 Al
1 Un#tID Instinmion Name students total)
126182 Adams State College 3121
1 |1nN434 Alabama A & M University 5327
4 1007241 Alabama State University =VLOOKDBA4,'D312 2'1A3:0267.13.0)
5 138716 Albany State University [ VLOOKUP{lookup_value, table_array, col_index_num, [range_lookup]) |
6 175342 Alcorn State University
7 222831 Angelo State University
8 197869 Appalachian State University
9 106458 Arkansas State University-Main Campus

IPEDS data file - Microsoft Excel

"AA B IEEL

a9
Homie

Microsoft Excel

Inset  Pagelayout  Formulas  Data  Review  View  Developer  Adddns  Acrobat
5 R Times Mew Roman =~ 11 - A 4 T == - ZH Wrap Text General - = ]
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Totalmen  women
Citylocationof ~ State  Grandtotal (EF2009 All (EF2009
institution abbreviation (EF2009 All students All smdents
1 UnitlD Instifution Name (HD2009)  (HD2009) stdentstotal)  total) total)
2 | 126182 Adams State College Alamosa co 3121 1272 1849
3 100654 Alabama A & M University Normal AL 5327 2413 2914
4 100724 Alabama State University Montgomery AL 5564 2108 3456
5 138716 Albany State University Albany GA 4473 1442 3031
6 | 175342 Alcorn State University Alcorn State MS 3334 1055 219
7 | 222831 Angelo State University San Angelo X 6387 2809 3578
8 197869 Appalachian State University Boone NC 16968 7835 9133
| 9 106458 Arkansas State University-Main s Jonesboro AR 12156 4820 7336
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t-Test in Excel

Installing Data Analysis Add-in to Excel

Information about T-Test Data
EA\Consulting Work\Excel Screenshots\T-Test Data\T-Test Data.dsx

Permissions
Anyone can open, copy, and change any part of this workbook.

Protect
Workbook *
. Prepare for Sharing
7 di Before sharing this file, be aware that it contains:
h _k: Document properties
ls:: e ?r Content that people with disabilities find difficult to read
Versions
{ _ﬂ %) There are no previous versions of this file.
Manage
Versions ~

General . .
. 45y View and manage Microsoft Office Add-ins.
Formulas

Praofing Add-ins

Save Mame - Type

Active Applicalion Add-ins

Acrobat PDFiMaker Office COM Addin A COM Add-in

Adgvanced Adobe Contribute Plugin COM Add-n
Convert with FlashPaper i OtficePri COM Add-in

Language

Customize Ribbon
Inactive Appliation Add-ins
Quick Access Toolbar Analysis ToolPak oL el ibranyAnalysis ANALYSI T XLL Excel Add.mn
K v = Analysis ToolPak - VBA O Micel 4 Library’ Analysis ATPYBAEN. LAM Excel Add-in
Custom XML Data PuaiMicrosaft Office\Officel 4\OFFRHD.DLL ~ Document Inspectar
Date (XML \microsoft shared'Smart TagiMOFLDLL  Action g
rust Center Euro Currency Taols Office\Officel4\Library EUROTOOLXLAM  Excel Add-in
Financial Symbol (XML} sumicrosoft sharediSmart Tag\MOFLDLL  Adtion
Hesders and Footers \Microsoft Office’ Officel 4\ OFFRHD.OLL Document Inspector
Hidden Rows and Columns L. iMicrosoft Office’ Officel 4 OFFRHD.DLL Document Inspector
Hidden Worksheets CoL.J\Microsoft Office\Officel4\OFFRHD.DLL  Document inspector
Invisible Content “L.JMicrosoft Office\Officel OFFRHD.OLL  Document inspector
Microsoft Adtions Pane 3 XML Expansion Pack
Solver Add-in o e\Officel 4 \Librany SOLVER\SOLVER XLAM  Excel Add-in

Document Related Add-ins

Add-n: Analysis ToolPak
Publisher: Microsoft Corporation
C Mo comp L

Location: C/\Program Files (E61 Microsoft Office'Officel4\LibranyAnalysis\ ANALYS32, XLL

Description:  Provides data analysis tools for statistical and engineering analysis

Manage: Excel Add-ins Z!




Add-Ins available:

i Analysis TooPak B
||| Analysis ToolPak - VBA '
[ | Euro Currency Tools

| Solver Add-n

“Analysis TooPak
Provides data analysis tools for statistical and




t-Test in Excel

Full-Time

Undergraduate

Retention Rate Gradation Rate Enroliment

g2
A
89
89

74 29,869
71 31,418
70 30,803
69 31,595

FSL Characterstic

Undergraduate
Enroliment

29,869
31,418
30,803
31,595

F5U Charactenstic

Sampling
t-Test: Pared Two 53

t-Test: Two-Sample Assuming Egual Variances

| t-Tests Two Uinequal Vanances
z-Test: Two Sample for Means

Time

-




B
Conditional Format

$8ll t-Test: Two-Sample Assuming Equal Variances

3 Full-Time Retention Rate
Sl Mean 90.25
El Variance 2.25
Observations 4
il Pooled Variance 3458333333

The columns need to be

8 Hypothesized Mean Difference 0 adjusted so the analysis

-

_' tStat 14.63902019 can be displayed properly.

88 P(T<=t) one-tail 3.1894E-06
iEl t Critical one-tail 1943180281
HEN P(T<=t) two-tail 6.37881E-06
W t Critical two-tail 2.446911851

F5U Characterslcs F3lJ Chacierstx -




- *Untitled1 [DataSet0] - SPSS Statistics Data Editor

File Edt View Deta Iransform Analyze Graphs  Utities

t-Test in SPSS

Importing Data into SPSS from Excel

Add-gns  Window  Help

B %0% ¥

ew B il 5B

{9
{
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2 save AlDste Look i

(& Rename Dataset..

Display Data File Information v |
% cache Data... |
£= Switch Server..,

[, erirt Preview

| Recently Used Deta >
| Recertly Used Eles >
| Ext !

| T-Test Deta

-] kil

(8] T.Test Data xisx

-t Opening Excel Data Source

Files of type: |E>m|§'m;-mx i

f‘_]li-‘ i icths b y

E:Wonsulting Work\Excel Screenshots\T-Test DatalT-Test Data xisx

[V Read variable names from the first row of data

Worksheet  |Fgu) Characteristics [A1:D8)

Range: |

Maximum width for string cokamns: (32767

ok J[ coc || new |




.t T-Test of FSU Characteristics.sav [DataSet1] - SPSS Statistics Data Editor
Ble Edt Vew Dota Transform  Anelyze Graphs  LNities Addons  Window  Help
cHE E o Rk A it SEE S0 v

1: Year 2010.0 Visible: 4 of 4 Varisbles
Year FullTimeRetention GradationRate 'Urtdargradua!eEnri : ii
___ Rate oliment | | | e (RSl L]
1 | Iﬂg 92 74 29869.0 ol !
2 | 2008 91 7 31418.0 H|
g 2008 a9 70 30803.0 |

4 | 2007 89 69 31595.0

t-Test Analysis

«st T-Test of FSU Characteristics.sav [DataSet1] - SPSS Statistics Data Editor
Fle Edit View Data Transform | Analyze Graphs Uities Add-ons  Windo
bﬂ& E’ & ?mﬁla Reports
1 Year 20100 |  Descriptive Statistics
Year |FullTimeRe S0y
Rate  General Linear Mode!
2010 | Generalized Linear Modeis
2009 Mixed Models
Correlate
2007 Regression
Loglinear
Classity
Dimension Reduction
Scale
Nonparametric Tests
Forecasting
Survival
Multiple Response
Quality Cortrol
ROC Curve...

W W BN W W

W=
o 2
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-t Paired-Samples T Test

69 Year . | |
& Full-Time Retention Rate... 1 &S FuTime... & Gradatio...
Gradation Rate [Gradst... | 2 -
lguﬂugrmegmm"_l ..t Paired-Samples T Test: Options @
|
' | Confidence intervat 99| %
L2 |

~Missing Values ———

—| | (¥ Exclude cases analysis by analysis
“4 | () Exclude cases fistwise

[connse J conca | e ]

e Syntax for T-Test of FSU Characteristics.sps - SPSS Statistics Syntax Editor

TASET ACTIVATE
T-TEST

There are three methods to run the syntax. :

After highlighting the syntax: s B

Toggle Bookmark

1. Under “Run” in the toolbar, click
“Selection”

2. Right click and click “Run Current”

3. “Crtl+R”

= T = ~




racteristics.spv [Document6] - SPSS Statistics Viewer

fnsert  Format  Analyze Graphs  Utiies Addons  Window  Help

» DRk 0% & Sus #éd +- B0 =53
T-Test
Paired Samples Statistics
Std Error
Mean N Sid. Deviation Mean
Pair1  Full-Time Retention Rate 80.25 4 1.500 750
Gradation Rate 71.00 4 2.160 1.080
Paired Samples Correlations
N Correlation Sia.
Pair1  Full-Time Retention Rate 4 926 074
& Gradation Rate
Paired Samples Test
Paired Differences
95% Confidence Interval of the
Difference
Std. Error . .
Mean | Std Deviation Mean r t t daf | siq (2-taled) |
Pair1 Full-Time Retention Rate 19.250 957 479 17.727 20773 40.212 000
- Gradation Rate




Regression in Excel

dd-in to Exce.

Installing Data Analysis A

Information about NCAA Institutions Data
E\Consulting Work\Excel Screenshots\Regression Data\NCAA Institutions Data.dsx
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Provides data analysis tools for statistical and




UnitiD Institution Name

104151 Arizona State University

Undergraduate

Enrollment Rate 2010

100858 Auburn University

223232 Baylor University

164924 Boston Collage

217882 Clemson University

198419 Duke University

134097 Florida State University

139755 Georgia Institute of Technology-Main Camy
il 151351 Indiana University-Bloomington

153603 lowa State University

il 155399 Kansas State University

el 159391 Louisiana State University and Agriculturall
Bl 171100 Michigan State University

In order for the
regression analysis to
function properly, the

dependent variable
needs to the in the first
column of variables.

ol 176080 Mississippi State University
SL 199193 North Carolina State University at Raleigh
il 147767 Northwestern University
:¥ 204796 Onio State University-Main Campus
207388 Oklahoma State University-Main Campus
il 209542 Oregon State University
W 214777 Pennsylvania State University-Main Campus
el 243780 Purdue University-Main Campus
il 243744 Stanford University
£8 228723 Texas A & M University
Ll 729115 Texas Tech University
100751 The University of Alabama
221755 The University of Tennessea
il 228778 The University of Texas at Austin
104179 University of Arizona
106397 University of Arkansas
110635 University of California-Berkeley
110662 University of California-Los Angeles
126614 University of Colorado Boulder
EX N 134130 University of Florida
S 139959 University of Georgia
145637 University of lilinois at Urbana-Champaign
153658 University of lowa
155317 University of Kansas
157085 University of Kentucky
163286 University of Maryland-College Park
il 135726 University of Miami
& 170976 University of Michigan-Ann Arbor
=l 174066 University of Minnesota-Twin Cities
176017 University of Mississippi Main Campus
Sl 178396 U y of Missouri-Columb
Wl 181464 University of Nebraska-Lincoln
LEERLNUIN- S8 NCAA Football Insts. Characten di
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UnitiD  institution Name

104151 Arizona State University
100858 Auburm University
223232 Baylor University
164924 Boston College
217882 Clawmson University
198419 Duke University
134097 Florida State University
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153603 lowa State University
I 155399 Kansas State University
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EEN 722723 Texas A &M University
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Pl 100751 The University of Alabama
FER 221759 The University of Tennessee
FCl 228778 The University of Texas at Austin
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Ol 106397 University of Arkansas
8 110635 University of California-Barkeley

y of Calif, Los Angel

68l 126614 University of Colorado Boulder
134130 Univarsity of Florida
139959 University of Georgia

EER 145637 University of Illinois at Urbana-Champaign
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EER 155317 University of Kansas

SN 157085 University of Kentucky

Bl 163286 University of Maryland-College Park

ESR 135726 University of Miami

8 170976 University of Michigan-Ann Arbor
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Sl 178396 University of Missoun-Columbia

181464 University of Nebraska-Lincain
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Bupilugen
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Samphng.

t-Teest: Pared Two Sample for Means

t-Test: Two-Sample Assuming Equal Variandes
t-Test: Two-Sample Assamng Unequal Vanances
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Regression Analysis
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100858 Auburn University
223232 Baylor University
164324 Boston College
217882 Clemson University
198419 Duke University
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The columns need to be
Regression Statistics : .
s e adjusted so the analysis

R Square 091593524 | can be displayed properly.
W adjusted R Square 0.883411903
Standard Error 2003233373
Observations 58

Il ANOVA

df sS MS F Significance F
4 1749.245005 437.3112513 108.9751706 6.6127€-25
53  212.6860292 4.012943947
57  1961.931034

Coefficients Standord Error t Stot P-value Lower 95%  Upper 95% Lower 95.0% Upper 95.0%

Intercept 52.01004428 1.998886493  26.0195086 7.38797E-32 48.0007857 56.01930286 48.0007857 56.01930286
8 Undergraduate Enrollment 3.43856E-05 3.410086-05 1.008353449 0.317866375 -3.40119E-05 0.000102783 -3.40119E-05 0.000102783
cB Graduation Rate Total Cohort 0.505986575 0.029333249 17.24959186 2.13521£-23 0.447151528 0.564821622 0.447151528 0.564821622

Gl Published In-State Tuition 2010-11  -6.37017E-05 3.68588€-05 -1.728262522 0.089763854 -0.000137631 1.02277E-05 -0.000137631 1.02277E-05
il Published In-State Fees 2010-11 -0.000503382 0.0003206 -1.570124034 0.122337816 -0.001146426 0.000139661 -0.001146426 0.000133661

ootbal [nsts. Character -




Regression in SPSS

Importing Data into SPSS from Excel

e
| 8] Regrestion and T-Test Practice dex
at

View [eta Transtorm  fnebze Grahs  Lies Addgns  Widow Ml
L B o0 LRk A Gd S48 300 ¥
1061510 Vishie: 7 of 7 Varisbles
| UnaiD InstitutionName FullTimeRetention UndergradusteEn- GraduationRateTo ¢ StateT PublichadinS:

0, S5 e St WL W . T Rate2010 | olment taiCohon | witon201011 | ees20i00 |
|+ [ 104151 Anzona State University 84 58562 59 7793 €< ] |
N 2 100858 Auburn University &7 0221 [ 7008 892
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153603 lowa State University a8 23104 70 6102 %5 I
155399 Kansas State University 81 19205 2 672 704 |
159391 Lowisiana State University and Agncultural &smp, Mechanical College 84 23685 &1 3968 179 I
171100 Michigan State Unwersity N -] 7 1ms2 o |
17ENEN Mizsizsipal State Unimrsity a2 15543 £ 5461 a
199193 Morth Carolina State University at Raleigh &8 26247 72 4853 1676 |
147767 Northwestern University 9 8535 94 36840 83 |
204796 Ohio State University-Main Campus a3 42082 8 541 are |
207368 Oklahoma State Unmersity-Main Campus 78 18374 58 4103 76 |
209542 Cregon State Uniersity & 19557 60 5760 1355
214777 Pennsyh State L Main Campus 92 504 & 14412 838 |
243780 Purdus Unneesity-Mam Campus &8s 373 66 a5z 478
243744 Stanford Universty 9% E940 =3} 38700 1472 |
228723 Texas A &amp, M University L] 39148 a0 567 3090
229115 Texas Tech University 82 25862 B3 4296 w74
100751 The University of Alabama 85 24882 67 700 o
B 221759 The Unmersity of Tennessee 86 21392 &0 6450 a32
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There are three methods to run the syntax.
After highlighting the syntax:

1. Under “Run” in the toolbar, click

“Selection”
2. Right click and click “Run Current”
3. “Crtl+R”
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